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Bin Tracking

Getting started with Bin Tracking
Bin Tracking allows Sage 300 users to track inventory items stored in multiple bins within a warehouse or
Sage 300 Inventory Control location. Bins could include shelves, slots, containers, barrels, pallets or draw-
ers.

You can configure Bins and Items in a Bin, define Bin allocation options for a range of Sage 300 trans-
actions in Order Entry, Inventory Control, Purchase Orders, RMA and other modules.

To get started,

Installing Bin Tracking 3
Bin Tracking License Screen 5

INSTALLING BIN TRACKING

Installation Steps
Bin Tracking is installed by executing the EXE program downloaded for installation. InstallShield will
execute and guide you through the installation steps, including whether to install documentation.

Before you Start

Download the program installer for the version of Sage 300 you are running (only available in the
Partner area of the Orchid website).
Before installing Bin Tracking, ensure that all users have logged out of Sage 300.

Installing the files

Log on to the server where Sage 300 is installed as a user with full administrator rights.
Run the previously downloaded InstallShield for the module.
If prompted to re-boot, then do so.

Tip:
Programs are installed in the Sage 300 program folder, in the OYXXA subfolder, where OY is the 2-let-
ter code for the Orchid module and XX depends on the Sage 300 version you are running:

Example: OY68A for Bin Tracking version 2021, OY69A for Version 2022, OY72A for Version 2025.
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Note: REGACC is run automatically as part of the installation process. If some files are locked during
the installation, the re-boot is required to unlock all files and complete the installation.

Important! If you install Sage 300 on each workstation, as well as the server, then you must do the
same with Bin Tracking. In this case, repeat the above steps for each workstation.

Activate Bin Tracking
Activate Bin Tracking in Sage 300 Administrative Services > Data Activation.

For details on activating modules, refer to the Sage 300 System Manager online Help (choose the Help
menu on the Sage 300 desktop) or review the chapter, Setting Up Security, in the System Manager Admin-
istrator Guide

License Details
To start using Bin Tracking, you need a valid serial number and license file.

If you don't have a valid license for Bin Tracking, you only see the License screen.

Refer to Bin Tracking License Screen on the facing page for details on entering Activation
Code.

Tip: If installing with a 30 day grace period, additional re-installations will not extend the grace period.

Enter License Details

The installation doesn't require a serial number anymore. You enter the serial number and activation
code in the License screen.

Note: This applies to Sage 300 versions 2019 and above. You need a serial number to install
an older version.

After you install the software, you need to activate Bin Tracking in one company using Sage 300 Admin-
istrative Services > Data Activation.

There are two options to enter the license details:

USE A 30 DAY TRIAL LICENSE FILE
To generate a 30-day trial license file, enter the serial number provided for your module and Save the
details.

AFTER PURCHASING A SUBSCRIPTION OR A PERPETUAL LICENSE
If you have purchased the module, enter the serial number and activation code provided by your
Sage 300 business partner.
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Note: The license applies to all the Sage 300 databases for the same installation. You only need to
enter the license details in one company.

Upgrading from a prior version
1. Download the new version install program from the Orchid website (Business Partner access only)
2. Obtain the serial number and activation code for the new version
3. Backup your existing database and programs as per Sage Upgrade guidelines
4. Execute the EXE program downloaded (as above for a new install).
5. In Sage 300 / Administrative Services / Data Activation, Activate Bin Tracking
6. Enter serial number and activation code in the Bin Tracking License screen. (as above)

Minimum Requirements
You need to use the same version for the core Sage 300 modules and Bin Tracking. For example, Bin
Tracking version 2025 requires Sage 300 System Manager version 2025.

Additional specific Sage 300 modules may be required to enable all functionality. Refer to Orchid Sys-
tems's website for details ( https://www.orchid.systems).

License Agreement

BIN TRACKING LICENSE SCREEN
To start using Bin Tracking, you need a valid serial number and license file.

If you don't have a valid license for Bin Tracking, you only see the License screen.

License screen
You use the Bin Tracking license screen to enter serial number and activation code.

When to use: 
After a new installation or an upgrade to a newer version of Sage 300.
After a subscription renewal, enter the activation code with the new expiry date.
View the components of the Orchid module you are licensed for.

How to use: 
Enter the license details, click the Add button to create the license file.
Restart the Sage desktop to enable the new license.
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Note: If you have multiple Sage 300 databases, you only need to enter the activation code details in
one company. When the licence details are entered on the first company, Bin Tracking creates the
OYXXA.lic file, which can then be read by all other companies configured on the same server.

30-day Trial License

If you don't have an activation code for Bin Tracking, you can create a 30-day trial license.

In the License screen, enter a serial number for the module, Sage 300 version and edition you are run-
ning.

Click the Add button. This create a 30-day trial license.

Tip: If you install a 30-day trial, enter a valid activation code before the trial expiry date to continue
using the application.

Subscription Licenses Expiry Date

You can check the subscription expiry date and enter a new activation code after a subscription renewal
is processed.

Subscription licenses have an expiry date. To continue using Bin Tracking, you will need to renew the sub-
scription and enter a new Activation code in the module License screen before the expiry date.

Contact your Sage 300 Business Partner for details.

Note: In the four weeks before the expiry date, users receive a warning message when logging into
Sage 300 (weekly for the first three weeks and daily in the last week). If you don't renew before the
expiry date, the software will become read-only.

Troubleshooting Activation Code
When saving the license information, the following problems may be encountered:

Activation code Invalid – verify the registered company name (displayed during installation) and serial
number entered match the details supplied to Orchid Systems when an activation code was requested.

Invalid serial number – the entered serial number is not valid for this product, Sage 300 version and edi-
tion.

Important! If the Sage 300 Version or Edition change, a new Serial Number and activation

code must be requested from Orchid Systems.

If the company name registered with Sage changes, a new Activation Code must be requested from
Orchid Systems.

Refer to detailed troubleshooting tips in Troubleshooting Activation Code,
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Activation code and available functionality
Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of Bin Tracking is only active if you have purchased the required
module component.

The license screen displays what components of the Bin Tracking module are included in the activation
code.

Steps to setup Bin Tracking
Step 1: Setup Bin Tracking Security. Refer to Bin Tracking Security

Step 2: Setup Bin Tracking Options. Refer to Bin Tracking Options on page 9

Step 3: Setup Bins. For details, refer to Bin Setup on page 15

Step 4: Setup Optional fields if required. Bin Setup - Optional Fields on page 21

Step 5: Enter or import the opening Bin Transfer Quantities. Take On Opening Bin Transfer Quantities
on the next page

Tip: Import templates are available in the Shared Data / Import Templates directory when you install
Bin Tracking.

For details, refer to the following topics:

Assigning Visual Process Flows 7
Take On Opening Bin Transfer Quantities 8
Bin Tracking Options 9
Bin Options - Field List 11
Bin Setup 15
Bin Setup - Screen Guide and Field List 18
Bin Setup - Optional Fields 21

ASSIGNING VISUAL PROCESS FLOWS
Bin Tracking include Visual Process Flows to guide through the setup and some key transaction pro-
cesses.
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Tip: Use the Assign Visual Process Flows screen in the Administrative Services folder to

assign process flows to users (including the ADMIN user).

Only the ADMIN user and users who have the required security authorization can assign

process flows.

Tip: For more information about security authorization, see Administrative Services

Security in the Sage 300 System Manager help.

TAKE ON OPENING BIN TRANSFER QUANTITIES
The way you take on your Opening Stock Balances for Bin Tracking depends if you are taking on IC Open-
ing Stock Balances at the same time or not.

Taking on Opening Stock Balances in Bin Tracking and I/C at the
same time :

Determine what I/C and P/O Transactions you will use to take on the I/C Opening Stock Balances
Configure Bin Tracking (BT Setup -> Options \ Pick Method Tab) such that the “Create Bin Trans-
fer” is set to “During Posting” for IC Receipts / IC Adjustments / PO Receipts (based on the IC /
PO Transaction you are going to use to take on the IC Opening Stock Balances)
Enter the associated bins on the Bin Transfer document that is created linked to you IC/PO source
document.

Taking on Opening Stock Balances in Bin Tracking when the stock
is already accounted for in IC
This can be done in one of two ways:

Option 1: Running an I/C Generate WorkSheet

1. Running an I/C Generate worksheet,

2. Enter the bins/quantities per item into the B/T Worksheet. The quickest way to achieve
this is to

a. Export the B/T worksheet
b. Add the bin numbers to the item/quantity lines in the Excel Worksheet
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c. Import the B/T worksheet (this will insert new rows for the item/bin combinations)
d. Make the item quantities zero on the lines which have no bin numbers

3. Post the Bin Count – to create a B/T Transfer for the put-aways and update the I/C Worksheet
4. Delete the B/T worksheet
5. Delete the I/C worksheet, unless you want to write off/up item quantities in I/C based on the bin

count.

Option 2 - Create Bin Transfer Documents

Create a manual Bin Transfer document and add rows for each item/bin combination you have

1. Document Type = None - it is not associated with a source document
2. Use a put away action for each item/bin/quantity combination
3. Complete the Bin Transfer document.

Tip:
You can import the Bin Transfer documents .

Refer to the Sage300\SharedData\Imports directory for import template layouts. There are import tem-
plates for Bin Transfer Documents which has no serials or lots, has serials, has lots and has both serials
and lots.

BIN TRACKING OPTIONS
Use this screen to configure the way you need Bin Tracking to work

You select options when you activate your Bin Transfer module. Once you have set up your module, use
this form when you need to change your selections.

This form lets you:

Specify the various picking and put away methods you can define per Inventory Control stock
movement. (Use the Picking Method tab.)
Specify the prefix and sequence to be used to identify Bin Transfer documents in your system. (Use
the Processing tab.) 
Define Item rules

Picking Method Tab
Use the Picking Method Tab to specify the various picking and put-away methods you can define per
Inventory Control stock movement.

You can also configure whether to Warn/Don’t warn the user during posting if there is insufficient stock.
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Processing tab
Use the Processing Tab to configure options used when creating and using Bin Transfer documents.

Choose the prefixes and next numbers to assign when you create a bin tracking document.
These numbers include a prefix (up to 6 letters) followed by a sequence number.
The prefix you assign must be unique
You can change these prefixes and next numbers at any time
Restrict the length of the number to be assigned to Bin Transfer documents. You can use a max-
imum length of 24 characters, including prefixes. 

Items Tab
Define the rules whether all items are to be bin tracked and/or which items are to be excluded from bin
tracking.

Field List
For detailed description of fields and controls, view Bin Options - Field List on the facing page.

BEFORE USING THE OPTIONS FORM
Before changing any of the settings or other information in the Options form, read Chapter 2 of the
Bin Tracking Getting Started guide and make sure you understand the impact the options have on
processing within Bin Tracking.

Note: You cannot change most of your choices in the Options form if other Bin Tracking forms are
open, or other users are working with the Bin Tracking database.

Make sure that no one else is using the Bin Tracking data and that no other Bin Tracking forms are
open for the company before you save changes to the Options form.

TO USE THE OPTIONS FORM

1. Click each tab to work in this form.
2. Click Save to keep any changes you make.
3. Click Close to leave the form without changing any information.

Updates Tab
NOTIFY ME WHEN THERE ARE NEW UPDATES IN BIN TRACKING

Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers
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The check is stored in the registry and it applies to this Windows user on this computer.

If selected, when starting Sage it will check if there are product updates available for Bin Tracking

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.

Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option

turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 

BIN OPTIONS - FIELD LIST
For details on how to use Bin Options, refer to Bin Tracking Options on page 9

Picking Method Tab
PROGRAM

This column shows the Sage 300 Transactions enabled for Bin Tracking.

Note: The configuration row for the O/E Order Entry screen only applies to when you create an OE
Shipment from this screen. The Bin Transfer document is only created when you create an OE Ship-
ment (either from the O/E Order Entry screen or O/E Shipment Entry screen), as the bins are only
assigned to a document when the movement in/out of the location is posted.

CREATE BIN TRANSFER

Select if the Bin Transfer will be created manually, or during posting of the source Sage 300 doc-
ument.

SET STATUS

Set the status of the newly created Bin Transfer document to one of:

Not ready for picking
Ready for Pick/Put Away

PICK METHOD
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For “pick” type documents (OE Shipment, I/C Transfer, I/C Assembly, PO Return) you can configure
the rules for Auto Picking based on one of

Bin Setup Pick Order – ie Bin Tracking will fill in the bin numbers based on the bins which have
stock, sorted in the Bin Setup Pick Order. If to Bins have stock and the same Bin Setup Pick
Order – then the first bin by alphabetical sorting of the Bin Numbers will be suggested
Most Recent Put Away – ie Bin Tracking will fill in the bin numbers based on the most recently
put away stock. If two Bins have stock with the same Put Away Date, then the first bin by alpha-
betical sorting of the bin Numbers will be suggested

Least Recent Put Away – ie Bin Tracking will fill in the bin numbers based on the least recently
put away stock. If two Bins have stock with the same Put Away Date, then the first bin by alpha-
betical sorting of the bin Numbers will be suggested

PICK FROM

Select one of the following methods to default the "Pick From" bin

Bin Setup Pick Order
Most Recent Put Away
Least Recent Put Away

PUT AWAY METHOD

For “Put-Away” type documents (PO Receipt, OE Credit Note, I/C Disassembly, I/C Receipt) you can
configure Bin tracking Pick Method to one of:

Manual – ie Bin Tracking will not suggest which bin to put the stock into
Auto Put-Away - ie Bin Tracking will suggest a bin to put the stock into, based on the Put-Away To
rules
Auto Put-Away and complete- ie Bin Tracking will suggest a bin to put the stock into, based on
the Put-Away To rules. Additionally Bin Tracking will set the status of the Bin Transfer to Com-
pleted (if the stock has been allocated to a bin)

DEFAULT PUT AWAY BIN TO

For “Put-Away” type documents (PO Receipt, OE Credit Note, I/C Disassembly, I/C Receipt) you can
configure the rules for Auto Put-Away to on one of

Blank – ie no Bin will be suggested
Last Bin Picked From – ie Bin Tracking will fill in the bin numbers based on the most recently
picked stock. If two Bins have stock with the same pick Date, then the first bin by alphabetical
sorting of the bin Numbers will be suggested
Last Bin Put Away To – ie Bin Tracking will fill in the bin numbers based on the most recently
put away stock. If two Bins have stock with the same Put Away Date, then the first bin by
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alphabetical sorting of the bin Numbers will be suggested
Bin Setup Put Away Order – ie Bin Tracking will fill in the bin numbers based on the bins which
have a put away order of 1, sorted in the Bin Setup Pick Order. If to Bins have stock and the
same Bin Setup Pick Order – then the first bin by alphabetical sorting of the Bin Numbers will
be suggested

POP UP BIN TRANSFER WHEN POSTING

Select:

Yes to force the Bin Transfer document to be shown on the screen immediately as the source
Sage 300 document is posted.
No if you do not want the Bin Transfer document to be shown on the screen as the source Sage
300 document is posted
"Only if binned" to force the Bin Transfer document to be shown on the screen immediately as the
source Sage 300 document is posted if

The location is bin tracked
At least one item on the source document is bin tracked

Examples:
With "Only if binned" option, if all items in the transaction are not bin tracked - Bin Transfer screen
won't pop up.

If a transaction includes bin tracked and not bin tracked items, the screen will popup.

AUTO-COMPLETE BIN TRANSFER WHEN NOT BINNED

If the locations on the generated Bin Transfer are not "Bin Tracked" and/or none of the items on a Bin
Transfer are bin tracked, you can select this option to auto-complete the document.

INCLUDE NONSTOCK ITEMS

Select one of:

Default: Use the option as defined in BT Setup > Options > Processing Tab.

No: Never include non-stock items

Yes: Always include non-stock items on Bin Transfers originating from the selected transaction type

WHEN AUTO-PICKUP DURING POSTING:

If there is not enough stock available to pick, select Warn to Warn or Don't Warn the operator when
posting the source transaction.

Processing Tab
BIN TRANSFER PREFIX
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Type the prefix you use in your existing document numbers, or use the default prefix you see on this
page. Each prefix can be up to six alphanumeric characters.

BIN TRANSFER LENGTH

The maximum length of the Bin Transfer numbers is 22 characters.

NEXT BIN TRANSFER NUMBER

If you do not want to use the default starting number for bin transfers, type over it. The program
increases the number by 1 each time you create a bin transfer, but you are not forced to use the num-
bers assigned by the program.

ALLOW NEGATIVE BIN QUANTITIES

Set this to “No” if you do not allow negative bin quantities. Set this to “Yes” if you do allow negative
bin quantities. 

ALLOW TRANSFERS IN STOCKING UOM

If you do not allow Bin Transfers in the stocking unit of measure, then use this option to enforce the
system to Allow/Disallow or Warn you if the Stocking Unit of measure is used. Options – Yes, No and
Warn. 

BIN FINDER

Determines which finder to show for item bins when processing Bin Transfer documents

Show all bins - This shows all bin codes and is generally faster.

Only show bins available for the item: The finder will show the bins and follows the Bin Tracking rules.
It only shows the bins where the item is available, and also displays quantities for the item in all avail-
able bins.

Note:
This may be slow in sites with many items and many bins.

In many cases, it is recommended to use an auto-pick method to allocate the bins based on the
preferred pick method.

ALLOW INCOMPLETE BIN TRANSFERS TO BE SET TO COMPLETED

There is no source Document: Yes/No

There is a source document: Yes/No/Warn

Select Yes if you allow bin transfer documents to be completed when the Bin Transfer Item quantities
do not match the associated source document item quantities.
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Select No if you don't allow bin transfer documents to be completed when the Bin Transfer Item
quantities do not match the associated source document item quantities.

Select Warn to warn the operator when the item quantities don't match.

DEFAULT INCLUDE NON STOCK ITEM

"Include non-stock items" option. It defaults to Yes.

If set to no then non-stock items are not copied to the Bin Transfer document.

Item Tab
Use the Item Tab to configure items that are not bin tracked.

Note: Even when the Item is not bin tracked, it is still recorded on the Bin Transfer details. The bin is
set to "Item is not Bin Tracked".

ALL ITEMS ARE BIN TRACKED, EXCEPT FOR THOSE BELOW

Select this option to allow all items to be bin tracked, except the items in the list below

ONLY THE ITEMS BELOW ARE BIN TRACKED

Select this option to turn off bin tracking on all items except those items in the list below

MASKS

Enter an item number or a mask for a range of item numbers to include in bin tracking or exclude
from bin tracking, depending on the selection above.

Example mask :

Z1-???-? would mean all items with a structure ZZ-ZZZ-Z and which

Start with Z1
Have any three characters/digit as the second segment
Have any character/digit as the last segment

BIN SETUP
Use this screen to create the required bin numbers per location.

BEFORE ADDING BINS

Choose a code of up to ten characters to identify each bin you plan to add.
Decide on your processing rules for your bins.

For details on fields and controls, Bin Setup - Screen Guide and Field List on page 18

This form lets you:
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Designate if a location is or is not bin tracked
Set up a record for each bin where you stock inventory items within a location.
Designate bins as temporary bins (which can be automatically made inactive in Periodic Processing
– when empty).
Designate bins as “allow all items” or specifically nominate which items are allowed in which bin
Set up a “Pick Order” for each bin
Designate if the bin is allowed for “put aways” or only for “picks” or both
Set up a “Put Away Order” for each bin
Assign a Quick Bin code (for example “S” for the “SHOP” bin) to facilitate data entry
Assign items to locations (if you do not use the Allow Items At the bin option).

Item Details per bin
For each bin created per location, you can :

Set up a record for each item you allow in the bin
If the bin “Allow All Items” is set to “Yes”, then you do not have to record each item.

DETAILS YOU CAN DEFINE PER ITEM IN A BIN

whether you “allow” or “do not allow” this item in this bin.
The picking sequence is displayed from I/C Item Locations.
You can define the default unit of measure in this bin (this is for display purposes only.
All stock movements per bin are done in the stocking unit of measure for the item)  
Allow different UOMs. Set to Allow if you allow all UOMs in this bin. Set to Don’t Allow if
you only allow stock movements in the Default UOM for this item in this bin. Set to Warn
if you want the system to warn you if you do any stock movement in/out of the bin in
any other UOM than the Default UOM. 
The restocking level (i.e. below this level, this item will be reported on as an exception
being below the restocking level)
The restocking quantity (i.e. the quantity by which this item in this bin should be
restocked – if the on hand quantity falls below the restocking level)

Per item in a bin, this screen displays

The current quantity on hand in the bin
The current quantity on hand in the location
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Tip:
If you need to override the Bin Setup configuration and lets users pick or receive from all bins when
processing a Bin Transfer (for example for Take-on balances), select "None" as the Source Document. It
allows users to: 

Pick from a bin which has "Allow Picking From" set to No - Refer to Bin Setup on

page 15 for details

Put away to a bin which has "Allow Receiving Into" set to No

Do a pick and put away - bin transfer - from any bin

Filtering records in the grids
On this form, you can press the Control “Ctrl” button to filter any of the columns as required :

By clicking “ctrl” in the Bin Grid – for example on the “Bin Number” column, you can filter on the bin
column as follows: 
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BIN SETUP - SCREEN GUIDE AND FIELD LIST
For details on how to setup Bin Tracking, refer to Bin Setup on page 15.

FIELDS AND CONTROLS
LOCATION

Enter a location to setup bins

THIS LOCATION IS BIN TRACKED

Check this box if the location is bin tracked

BIN

Enter the Bin number. The bin number can be up to 10 characters (A..Z, 0..9) long. 

DESCRIPTION

Enter a description for the bin

ACTIVE

Select if the Bin is active Yes/No

TEMPORARY BIN
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Select if the Bin is a Temporary Bin - Yes/NoTemporary Bins can be made inactive by using
the Periodic Processing Task.

ALLOW ALL ITEMS

Select if the Bin allows all items - Yes/No

PICK ORDER

Enter the picking order which the goods will be picked

PUT-AWAY ORDER

Select the order in which your items will be put away

ALLOW RECEIVE INTO

Select Yes if you allow the Receiving source documents (PO Receipts and I/C Receipts) to put
away stock into this bin. Select No if you do not allow receiving in this bin. 

ALLOW PICKING FROM

Select Yes if you want to allow picking from the bin.

Select No if you don't allow pickup from this bin.

QUICK BIN CODE

Enter a shortcut code if required. If entered, then the operators can type just the short cut
instead of typing the full bin code. 

For example if you always pick from bin A10101, you might want to call this Bin “A”. By typing
A in the Quick Bin Code, it is equivalent to typing in the full bin code. 

ITEM DETAILS
ITEM NUMBER

If you are restricting items in a bin, then the allowed item codes must be entered (or selected).
If you wish to define a restocking level and restocking quantity for an item in a bin, then the
item number must be entered or selected. 

DESCRIPTION

The item description is displayed.

ALLOW ITEM IN THIS BIN

Yes/No. You can optionally restrict an item in a bin (Yes = allow this item in this bin, No = do
not allow this item in this bin) 
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PICKING SEQUENCE

Displayed from I/C Location

UNIT OF MEASURE IN THIS BIN

Optional. If you define a unit of measure for this item in this bin, then the system can “warn” or
“error” if you do bin transfers not using this unit of measure for this bin depending on the set-
ting for “Allow different UOMs” 

ALLOW DIFFERENT UOMS

Allow/Don’t Allow/Warn. If Don’t Allow or Warn is selected and a bin transfer document uses a
different unit of measure as to the one defined for this item and bin, then Bin Tracking will
warn or stop the entry. 

CURRENT QUANTITY

The current total number of items (in stocking unit of measure) for this item in this bin is dis-
played.

QUANTITY IN I/C

The current quantity on hand for this item in this location is displayed. (from I/C Item Loca-
tions)

RESTOCKING LEVEL

If required you can enter a restocking level for this item in this bin. If entered and the bin quant-
ity for this item is less than the restocking level, then this item/bin combination will be printed
on the Bin Replenishment report 

RESTOCKING QUANTITY

If using restocking levels, you can enter the quantity by which the item should be restocked in
this bin

MAXIMUM QUANTITY

Maximum quantity for the item in this bin. For documentation only as Bin Tracking does not
validate that the maximum quantity is not exceeded.

SERIAL NUMBERS

Displays the serial numbers assigned to this item in this bin. Click the Zoom (^) button to see
the serial numbers.

LOT NUMBERS
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Displays the lot numbers assigned to this item in this bin. Click the Zoom (^) button to see the
lot numbers.

LOT QUANTITY

Displays the lot numbers and associated quantities assigned to this item in this bin. Click the
Zoom (^) button to see the lot numbers.

LOTS WITH NON-ZERO QUANTITIES

Displays a list of lots with non-zero quantities only.

Tip: The Bin details can be imported from Excel.

BIN SETUP - OPTIONAL FIELDS
You can use the B/T Optional Fields screen to assign optional fields to Bin Tracking transactions and bins.

Before you start
Create Optional Fields in Common Services.
Use the Bin Tracking Optional Fields screen to assign them to Bin Tracking transactions and
records.

Where to add Optional Fields in Bin Tracking

Optional fields that you add to Bins appear in the Optional Fields tab on Bin Setup
screens.
Optional fields that you add to Bin Transaction Header appear in the Optional Fields
tab on transaction entry screens.
Optional fields that you add to Bin Transaction details appear as columns in the Detail
table on transaction entry screens.

Tip: If the Bin Tracking optional fields are called the same as in the other modules (IC/OE/PO), and
they are attached at the same level in Bin Tracking and the source module, then the optional fields will
be copied from the source module to the associated Bin Transfer document.

Example: If you add the same optional field on the OE Shipment Header and the BT Bin Transfer
Header, the optional field value will be copied from the OE Shipment Header to the Bin Transfer
Header when the OE Shipment is posted.
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Note:
When you run a Data Integrity Check in Bin Tracking, if an Optional field on Bin Tracking Documents
(Header or Detail) is set to "Required", all documents are checked, including historical documents, as
Bin Tracking doesn't know when the optional field was made required.

If you add a Required Optional field to the Bin Transaction documents (header or detail) after doc-
uments have been created, you may get data integrity errors for all documents created before the
Optional Field was made Required. You can ignore such Data Integrity errors for transactions created
before the optional field.

Bin Tracking Transactions
Using Bin Tracking, you can transfer items between bins and complete bin transfers by status.

The setup steps are described in the Visual Process Flow (VPF) below followed by detailed steps. To
assign VPF, see Assigning Visual Process Flows on page 7

Bin Transfer 23
Bin Transfer - Field List 27
Pick Status 31
Pick Status - Field List 32
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BIN TRANSFER
Use this form to:

Enter and complete Bin Transfer documents – recording the location/bin/item details and the asso-
ciated quantity either in or out of the bin – for manually created Bin Transfers
Update and complete Bin Transfer documents - recording the location/bin/item details and the
associated quantity either in or out of the bin – for documents created by O/E, I/C and P/O.
Import bin transfer transactions from other Sage 300 databases or from non-Sage 300 programs.
Export bin transfer transactions.

For details on Fields and controls, refer to Bin Transfer - Field List on page 27

Types of bin transfers

Bin Transfers can be associated to all stock movement types found in Inventory Control . The associated
Bin Transfer document can either be created 

Manually
During posting of the original source document (in O/E, I/C and P/O)

Tip:
Select None in the Source Document to save a Bin Transfer not linked to Sage 300 documents, such as
Take-on balances.

This option overrides the Bin Setup configuration and lets users pick or receive from all bins. It allows
users to: 

Pick from a bin which has "Allow Picking From" set to No - Refer to Bin Setup on

page 15 for details

Put away to a bin which has "Allow Receiving Into" set to No

Do a pick and put away - bin transfer - from any bin

Depending on how the B/T Options have been defined, source transactions may be associated (either
automatically during posting, or manually created) with Bin Transfer documents :

SOURCE TRANSACTIONS

None - Use this option to allow users to pick or receive into any bins, whether you are allowed
to receive into or pick from.
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O/E Shipments
O/E Credit Notes
O/E Debit Notes
I/C Transfer
I/C Receipt
I/C Shipment
I/C Return
I/C Adjustment
I/C Assembly
I/C Disassembly
I/C Internal Usage
P/O Receipt
P/O Return
RMA PO Return
RMA OE Credit Note

AUTOSIMPLY OPTIONS

AutoSimply Returns (I/C Adjustment)
AutoSimply Batch Returns (I/C Adjustment)
AutoSimply Returns by Product (I/C Adjustments)
AutoSimply Receipts (I/C Adjustments)
AutoSimply Batch Receipts (I/C Adjustments)
AutoSimply Kanban MO Entries (I/C Adjustment)
AutoSimply Issuances (I/C Adjustment)
AutoSimply Batch Issuances (I/C Adjustment)
AutoSimply Issuances by Product (I/C Adjustment)
AutoSimply MO Backflush (I/C Adjustment)
AutoSimply KanBan MO Entries (I/C Shipment)
AutoSimply Issuances (I/C Shipment)
AutoSimply Batch Issuances (I/C Shipment)
AutoSimply Issuances by Product (I/C Shipment)
AutoSimply MO Backflush (I/C Shipment)

Note: : Auto Simply Options will only be shown if the associated module is activated in

the current database

TO ENTER TRANSFERS
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1. Double-click the Bin Transfers icon in the Bin Tracking folder.
2. Press the Tab key to start a new bin transfer and accept the program-assigned number (or click

the New button if you have already entered or looked up a transaction).
3. Choose the source document of the bin transfer transaction you are entering and then select

the appropriate document. The appropriate item and location information will be displayed. 
4. If you have configured “pick” documents to “auto pick”, then the suggested bin and associated

quantities will be displayed per item. These can be amended. 
5. If you have not configured “auto pick”, then – for “pick” documents, you can click “Auto Pick”

to let Bin Tracking suggest the most appropriate bins for the items to be picked from.
6. For “put away” type documents, the actual bin and quantity per item must be entered.
7. Click Add or Save.
8. If you have “completed” the document (i.e. all items have been fully picked or put away), but

you have not changed the status to “complete”, then Bin Tracking will prompt you to confirm if
the document is complete.

9. When you first start working on a “Pick” or “Put Away” transfer document, you can change the
status to reflect what is required : 

Not Ready for Picking
Ready for Picking/Put Away
Pick /Put away in progress
Complete

SELECT ALL TO PICK/PUT AWAY ALL ROWS
Bin Transfers - added 'Select All' button to the serial/lot window to pick/put away all rows.

You can also press space /delete on the quantity column on the main screen to pick all rows or set
the quantity to 0.

IF USING SERIAL NUMBERS OR LOT TRACKING
If you have serial (or lot numbers) then pressing F9 on the quantity field brings up a window for the
serials / lots.

Note: The Bin Transfer documents include non-stock items and non bin-tracked items for reference.
Such items don't need to be updated and assigned to a bin when processing the document.
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Tip:
If you select "Only show bins available for the item" for "Bin Finder" in BT Setup -> Options > Pro-
cessing tab, then when you

Click on the Bin Finder for an item detail row on the Bin Transfer document

Then click on the Bin Finder in the Quantities pop up

The finder will show the quantities for that item in all available bins

Refer to Bin Options - Field List on page 11 for details

Important!
If you are using "Update O/E Shipment" on the B/T Bin Transfer Document to update amended serial
numbers / lot numbers entered on the Bin Transfer Document back to the original source OE Ship-
ment, you must set the O/E Option "Default Create Invoice Option" to "No" (O/E Setup -> O/E Options
\ Processing tab)

If "Default Create Invoice Option" is set to "Yes", when the Bin Transfer document updates the OE Ship-
ment, the OE Shipment will automatically be invoiced - irrespective of the selection made on the
"Create Invoice" option on the Bin Transfer Document.

After using

Use the Bin Transfer Form to print the bin transfer.

Optional Fields Tab
If optional fields are assigned to the screen, use the Optional Fields tab to enter optional field inform-
ation that applies to the entire document.

Optional fields and values appear automatically on this tab if you selected the Auto Insert option for
those fields on the B/T Optional Fields setup screen.

If you use identical optional fields in Bin Tracking transactions and Order Entry invoices, the information
in the Order Entry fields is sent to Bin Tracking optional field

Note: If an optional field is required but does not have a default value, you must specify a value for the
field.
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BIN TRANSFER - FIELD LIST
For details on how to use Bin Transfer, refer to Bin Transfer on page 23

HEADER:
DOCUMENT NUMBER

To add a new Bin Transfer, press the Tab key, click the New button. If you do not want Bin
Tracking to assign the order number, type the new number yourself. 

STATUS

Select the appropriate status for the bin transfer document

COMMENT

Enter an optional comment for the bin transfer document

SOURCE DOCUMENT

Select the Sage 300 Source Document type for this bin transfer. If this transfer is not associated
with a Sage 300 Source document, select None (for example for the take on bin quantities). 

OPEN

Allows you to open the associated source document

LAST UPDATED BY

The user id, date and time this bin transfer document was last updated is displayed.

CREATE INVOICE

Select this option if you want Bin Tracking to invoice the OE Shipment when the associated Bin
Transfer is completed.

Will only appear if OE Shipment is selected in the Source Document.

UPDATE O/E SHIPMENT (WILL ONLY APPEAR IF OE SHIPMENT IS SELECTED AS
THE SOURCE DOCUMENT)

If this option is ticked then any changes to the quantities, serials/lots that are made (on the BT
transfer screen) will be made on the OE Shipment screen. So if you change the Serial/Lot num-
ber on the Bin Transfer and tick the box, the quantity, Serial/Lot number on the OE Shipment
will also be changed. 
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Important!
If you are using "Update O/E Shipment" on the B/T Bin Transfer Document to update
amended serial numbers / lot numbers entered on the Bin Transfer Document back to the
original source OE Shipment, you must set the O/E Option "Default Create Invoice Option"
to "No" (O/E Setup -> O/E Options \ Processing tab)

If "Default Create Invoice Option" is set to "Yes", when the Bin Transfer document updates
the OE Shipment, the OE Shipment will automatically be invoiced - irrespective of the selec-
tion made on the "Create Invoice" option on the Bin Transfer Document.

UPDATE P/O RECEIPT (WILL ONLY APPEAR IF PO RECEIPT IS SELECTED AS THE
SOURCE DOCUMENT)

If the source document selected is PO Receipt you will have an option to Update P/O Receipt.
If this option is ticked then any changes to the quantities, Serial / Lot numbers that are made
(on the BT transfer screen) will be made on the PO Receipt screen. So if you change the Item
quantities , Serial / Lot number on the Bin Transfer and tick the box, the item quantities, Serial /
Lot number on the PO Receipt will also be changed.

BIN TRANSFER LINE TAB:
ACTION

Select the required action (Pick, Put away or Pick and Put Away)

Tip:
If you want to quickly select put away, without having to use the dropdown, you can press a
keyboard shortcut instead.

P =Pick

A = Put Away

B = Both Pick and Put Away

ITEM NUMBER

Enter or select the required I/C Item

DESCRIPTION

The I/C Item description is displayed

STOCKING UNIT OF MEASURE

The stocking unit of measure for this item is displayed
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FROM LOCATION

For a Pick action, select or type the required pick location code

FROM BIN

For a Pick action, select or type the required bin code from where the item will be/was picked
(either the full bin code or the bin shortcut code)

Tip: If the item is being picked from multiple bins, click on the "From Bin" column
header and enter the bins and associated quantities on the list. The Bin Transfer detail line
will now show "multiple bins' in the From Bin Column.

PICKED

Enter the quantity picked (or to be picked)

PICKED UNIT OF MEASURE

The pick unit of measure is displayed

TO LOCATION

For a Put Away action, select or type the required put away location code

TO BIN

For a Put Away action, select or type the required bin code to where the item will be/was put
away (either the full bin code or the bin shortcut code)

PUT AWAY

Enter the quantity put away (or to be put away)

If you have serial or lot numbers, then press F9 or click on in the "Put Away" column
header while on the quantity field brings up a screen to enter the serial / lot numbers.
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Tip:

If the item is being put away in more than one bin, click on the Bin column header and
complete the list of bins/quantities. The Bin Transfer details line will share "multiple bins' in
the To Bin Column.

PUT AWAY UNIT OF MEASURE

The put away unit of measure is displayed

MANUFACTURER'S ITEM NUMBER

The I/C Manufacturer's Item Number is displayed

IS COMPLETE

Displays the status of the item line

OPTIONAL FIELDS (DETAIL LINE)

If optional fields have been configured for the Bin Transfer detail, enter the optional field val-
ues.

OPTIONAL FIELDS TAB
If optional fields have been configured for the Bin Transfer header, enter the optional field values.

SELECT ALL
Select All to Pick/put away all rows

Bin Transfers - added 'Select All' button to the serial/lot window to pick/put away all rows.
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You can also press space / delete on the quantity column on the main screen to pick all rows or
set the quantity to 0.

BUTTONS AND CONTROLS
AUTO PICK

Click this button for the system to suggest picking bins for items which require picking. See
Setup Options – Picking Method for a description on ranking bins for auto picking. 

AUTO PUT AWAY

Click this button for the system to suggest put away bins for items which require putting away.
Put away quantity will be amended if the quantity on the source document (e.g. PO Receipt) is
amended.

See Bin Options - Field List on page 11 for a description on ranking bins for auto put away.

PICK STATUS
Use this screen to view / amend Bin Transfers which are not yet complete

For details on the fields and controls, refer to Pick Status - Field List on the next page

Use this form to review which Bin Transfer Documents are

Not Ready for picking
Ready for picking/put away
Pick/Put away in progress

View/Amend Bin Transfer documents

Drill into the associated Bin Tracking document by double clicking on the Bin Tracking Document
number
Drill into the source document by double clicking on the required Source Document number
Change the status of the Bin Transfer document by clicking on the status column, and selecting
the required status
Print the associated Bin Transfer document by clicking File > Print Bin Transfer Document

Filter documents on the screen

By turning on and off the 3 options “Not Ready”, “Ready” and “In Progress” at the bottom of the
form
By clicking “Ctrl” on any column, and selecting the required value for the column which was clicked
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Refresh screen

Refresh the form by clicking the “Refresh” button.

The Form will refresh every 60 seconds while left open. 

Tip: Use File > Auto Refresh Every minute to toggle the Auto-Refresh on and off.

PICK STATUS - FIELD LIST
For details on how to use this form, refer to Pick Status on the previous page

FIELDS AND CONTROLS
DOCUMENT NUMBER

The bin transfer document number is displayed

DOCUMENT NUMBER (DRILL DOWN)

Double click on the Document Number or Click the drill down icon to open the appropriate bin
transfer document

SOURCE DOCUMENT NUMBER

Double click on the Document Number or Click the drill down document to open the appro-
priate Sage 300 Source Document (OE Shipment, PO Receipt, I/C Transfer etc)
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SOURCE LOCATION

Shows the location for pick documents

Tip: Filter using CTRL-F on this column to see only Bin Transfer Documents in this source loc-
ation

DESTINATION LOCATION

Shows the location for Put Away documents

Tip: Filter using CTRL-F on this column to see only Bin Transfer Documents in this des-
tination location

LAST UPDATED BY

User id of the last person to modify the Bin Transfer document is displayed

LAST UPDATED ON

The date the bin transfer document was last updated is displayed

LAST UPDATE AT

The time the bin transfer document was last updated is displayed

STATUS

The current bin transfer status is displayed. Double click and select an alternative status if
required. The associated bin transfer document will be updated.  

SCREEN CONTROLS
REFRESH

Click refresh to update the bin transfer documents displayed. The BT Picking Status screen will
be refreshed every 60 seconds (if not clicked) 

NOT READY

Select this option to show bin transfer documents with a status of “Not Ready for Picking/Put
Away”

READY

Select this option to show bin transfer documents with a status of “Ready for Picking/Put
Away”

IN PROGRESS
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Select this option to show bin transfer documents with a status of “Pick/Put away in progress”

CTRL-F To Apply A Filter

Click CTRL-F in any column to apply a filter – and select the filter. For example, to filter only “O/E Ship-
ment” source documents, click CTRL in the “source document” column, and then select the “Source
Document = O/E Shipment” source type as shown below. 

If a filter is applied to the screen, the filter will be shown along the bottom of the screen.

Item and Bin Inquiry
This form lets you:

View selected location, bin and item details.
Details available per item per location / bin : I/C Location quantity, B/T location/bin quantity and a
“yes/no” indicator if these are not in balance .
You can filter by either entering the from/to Location, Bin and item details above the grid or
You can filter by clicking “CTRL” on the required column and selecting the required filter
Print your current filtered list by clicking File > Print

For details, refer to Item and Bin Inquiry - Field List
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Bin Tracking Physical Inventory
The setup steps are described in the Visual Process Flow (VPF) below followed by detailed steps. To
assign VPF, see Assigning Visual Process Flows on page 7

Bin Tracking Stock Take Procedures 35
Bin Worksheet Report - Features 38
Generate Bin Worksheet 38
Bin Worksheet - Field List 40
Bin Inventory Counts 41
Bin Inventory Counts - Field List 42
Bin Reconciliation Report - Features 44
Post Bin Reconciliation 45
Post Bin Reconciliation - Field List 46

BIN TRACKING STOCK TAKE PROCEDURES

There are two ways you can enter the stock count by bin
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The first is by associating the Bin Count to an I/C Stocktake worksheet - By posting the
I/C Inventory Reconciliation, you will adjust the GL by the write ups and write downs.

The second is by associating the Bin Count to an I/C adjustment – and by posting the
I/C Adjustment you will adjust the GL by the write ups and write downs.

Tip: If you want to do a cycle count by bin number, use a Bin Tracking Generate Inventory Worksheet
and I/C Adjustments.

Bin Count using the I/C Stock take worksheet
1. Ensure all open Bin transfers are completed
2. Ensure all open Stock receipts are posted
3. Ensure all open Sales Shipments are posted
4. Run a day end
5. Freeze stock processing
6. Run an I/C Generate Inventory Worksheet. This will create an I/C Inventory Worksheet and a BT

Inventory Worksheet. Select “Item Number” as the “Sort by” on the Generate I/C Worksheet option
to ensure the I/C Worksheet is indexed by item number. This will reduce the update time of the I/C
Worksheet on completion of the BT quantity count.

7. Enter (or scan) the inventory count by bin into the BT Inventory Counts
8. Print and check the BT Bin Reconciliation Report
9. Post the Bin Reconciliation. The Bin Transfer that is created will adjust the quantities

per item per bin per location. The I/C Inventory count will be updated with the total per
item per location.

10. Check the BT Stock count worksheet – if all items have been updated in I/C and Bin
Tracking, the BT worksheet will be deleted. if any errors for any items are found then
the I/C worksheet will not be updated and BT Bin Transfer will not be created. The items
with issues on the BT worksheet will be updated with a status of “Pending” or “Insuf-
ficient Stock”, and the reason column will be updated with more details as to why the
item on the worksheet cannot be posted. The errors must be corrected prior to the
worksheet being re-posted.

11. Print and check the I/C Inventory Reconciliation
12. Post the I/C Inventory Reconciliation
13. Print the Bin Totals vs Location Totals reports, to confirm all items in the stock take are

in sync.
14. Start stock processing
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Bin Count using the BT Stock Take Worksheet
1. Ensure all open Bin transfers are completed
2. Ensure all open Stock receipts are posted
3. Ensure all open Sales Shipments are posted
4. Run a day end
5. Freeze stock processing
6. Run a BT Generate Inventory Worksheet. This will create a BT Inventory Worksheet
7. Enter (or scan) the inventory count by bin into the BT Inventory Counts
8. Print and check the BT Bin Reconciliation Report
9. Post the Bin Reconciliation. The Bin Transfer that is created will adjust the quantities

per item per bin per location. An I/C Adjustment will be created with the total per item
per location that needs to either be written up or written down. You will be prompted
with a choice on how the stock adjustment is created

a. If you have run the BT Generate Inventory Worksheet for a selection of bin-
s/items, then select the first option “Adjust I/C quantities with the change in
quantity entered in the Bin Worksheet”

b. If you have run the BT Generate Inventory Worksheet for all bins/items, then the
second option “Adjust I/C quantities with the quantity required to make the I/C
quantity for this location equal to the adjusted quantity in the Bin Worksheet”

10. Check the BT Stock count worksheet – if all items have been updated in I/C and Bin
Tracking, the BT worksheet will be deleted. if any errors for any items are found then
the I/C adjustments and BT Bin Transfer will not be created. The items with issues on
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the BT worksheet will be updated with a status of “Pending” or “Insufficient Stock”, and
the reason column will be updated with more details as to why the item on the work-
sheet cannot be posted. The errors must be corrected prior to the worksheet being re-
posted.

11. Print and check the I/C Adjustment that the previous step created.
12. Post the I/C Adjustment.
13. Print the Bin Totals vs Location Totals reports, to confirm all items in the stock take are

in sync.
14. Start stock processing

BIN WORKSHEET REPORT - FEATURES
The Bin Tracking Inventory Worksheet provides an organized form which you can fill out when taking a
physical count of inventory in bins. Use the report to enter total quantities for each item in each bin to
prepare for inventory reconciliation.

Information printed on the report

The date on which you generated the worksheet, together with

Item and item description
Bin
If selected, the quantity on hand in the bin/item combination
A column for the quantity counted to be recorded
The default UOM of the item/bin combination
A column for the status to be recorded

The report can print details of Serialized and Lot numbers

For instructions on printing the report, see Bin Worksheet Report - Printing

GENERATE BIN WORKSHEET
Use this form to generate worksheets for item quantities on hand for all bin locations for which you are
taking inventory.

For details on the fields, refer to Bin Worksheet - Field List on page 40

Page 38 of 62 Bin Tracking Physical Inventory

../../../../../../Content/Bin-Tracking/OY-Inventory-Stocktake/Bin-Worksheet-Report-Printing.htm


Bin Tracking

You can optionally print worksheets to use for recording your physical inventory counts prior to entering
the data in the Physical Inventory Quantities form and posting it to your Bin Tracking system.

You can create inventory worksheets for a range of bin locations, range of items, range of locations and
range of picking sequences. You can choose to include:

Only the items in the specified item/bin/location/picking sequence range that are assigned to the
bin(s) for which you are generating worksheets.
Only the items in the specified item/bin/location/picking sequence range that are assigned to the
bin(s) and currently have quantities in the bin(s) for which you are generating worksheets.

If you generate a bin inventory worksheet for a location that already has a worksheet, the program
replaces the old worksheet with a new one. The program warns you if there are existing worksheets for
locations and lets you choose whether to replace them.

Warning! To ensure quantities on Bin Tracking worksheets are current, do not post trans-

actions (receipts, shipments, transfers, adjustments, or assemblies) then run Day End Pro-

cessing between the time you generate bin inventory worksheets and the time you the

post the inventory reconciliation.

Before Generating an Inventory Worksheet you should

Run Day End Processing to update the company's Inventory Control data if you have posted trans-
actions since the last time you ran Day End Processing. (You should run Day End Processing even if
you cost items during posting.)
Decide on the inventory bins, locations, picking sequences and items for which you want to gen-
erate worksheets.

Generating a Bin Worksheet
1. Double-click the Generate Bin Inventory Worksheet icon in the B/T Physical Inventory.
2. Specify a range of bin locations, range of items, range of locations and range of picking sequences

for which you require the worksheet.
3. Specify the method by which to select the items to be listed on the worksheet.
4. Specify if you want the inventory count to reflect the quantity on hand per item per bin per loc-

ation, or default to zero
5. Click Generate

After Generating an Inventory Worksheet
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If desired, use the Bin Inventory Worksheet form to print inventory worksheets on which to record
physical inventory counts.
Use the Bin Inventory Count form to enter or import physical inventory counts for inventory work-
sheets.

BIN WORKSHEET - FIELD LIST
For an overview, refer to Generate Bin Worksheet on page 38

FIELDS AND CONTROLS
FROM LOCATION / TO

Enter the location range for which Bin Inventory Worksheets must be generated

FROM BIN / TO

Enter the bin number range for which Bin Inventory Worksheets must be generated

FROM ITEM / TO

Enter the range of item numbers you want to include on the Bin Inventory worksheets, or use
the Finders to select the first and last item number in the range.

FROM ITEM PICKING SEQUENCE / TO

Enter the range of Item Picking Sequence whose items you want to include on the Bin Invent-
ory worksheets, or use the Finders to select the first and last in the range.

FROM BIN PICKING SEQUENCE/TO

Enter the range of Bin Picking Sequence to select items you want to include on the Bin Invent-
ory worksheets, or use the Finders to select the first and last bins in the range.

INCLUDE

Specify which items you want to include on the worksheets by selecting one of the following
options from the Include list:

All Items from Bin - this will include all items that have been placed in the bin that are
in the Sort By range.
All In Use Items from Bin - this will only include current items in the bin that are in the
Sort By range.

DEFAULT QUANTITY ON HAND
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Specify if you want the inventory count to reflect the quantity on hand per item per bin per loc-
ation, or default to zero.

INCLUDE INACTIVE LOCATIONS

Tick if you want to include Inactive Locations when generating a Bin Worksheet

BIN INVENTORY COUNTS
For details on fields, refer to Bin Inventory Counts - Field List on the next page

When you use either

I/C Generate Inventory Worksheet to generate worksheets of item quantities on hand for all invent-
ory locations for which you are taking inventory
B/T Generate Bin Worksheet to generate worksheets of item quantities on hand for all inventory
assigned to bins for which you are taking inventory

The associated Bin Tracking Inventory Worksheet will be created.

Use this form to:

Enter inventory counts after counting inventory. Counts are entered per item per bin. 
Edit inventory worksheets (if needed) in preparation for posting Bin Tracking reconciliations.

You can enter counted quantities (which are all zero on newly generated worksheets). You can delete a
worksheet (use the Delete button), and you cannot delete individual lines (use the Delete key).  

When the Bin Inventory Worksheet is posted depending on how the BT worksheet was created, the post-
ing will:

Update I/C Worksheet (if BT worksheet was created from the I/C worksheet). BT will update the
associated I/C worksheet with the total quantity per item per location. 
Create I/C adjustment (if BT worksheet was created from the BT Generate Bin Worksheet). BT will
create the I/C adjustment with the total variation in quantity per item per location. 

In addition when the BT worksheet is posted a bin transfer will be created for any bin movements.

When posting a Bin Tracking Physical Inventory count based on a bin number range (ie the Bin Tracking
Physical Inventory worksheet was generated by Bin Tracking, not Inventory Control) you can optionally
create the I/C adjustment with

the change in the quantities in the Bin Tracking Physical Inventory Worksheet – relative to the ori-
ginal Bin Tracking Worksheet quantity. 
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the change required to adjust the original I/C Inventory quantity to equal the adjusted Bin Track-
ing Physical Inventory Worksheet quantity. Note : this option should NOT be selected if all the
stock for the relevant items in this location has NOT been counted
.

Note: I/C supports Serial and Lot tracking amendments via quantity only. So, for example

if you have 6 of an item, all assigned to a single lot number, you cannot (via the stock take)

amend the item to have 5 assigned to one lot, and one assigned to another lot. You can

increase or decrease the quantity (and assigned lot), but not “change” the lot only. Accord-

ingly, in the Bin Tracking stock take worksheet generated from I/C if you amend the item to

have 5 to one lot, and 1 to another - this will be allowed in Bin Tracking but will give an

error when posting through to the I/C Stock take.    

For details, refer to Post Bin Reconciliation on page 45

BIN INVENTORY COUNTS - FIELD LIST
For an overview, refer to Bin Inventory Counts on the previous page

FIELDS AND CONTROLS
BIN

Enter the bin number

ITEM

Enter the Item Number

DESCRIPTION

The I/C Item description is displayed

QUANTITY COUNTED

Enter the physical quantity that has been counted.

If you enter a quantity for a serialized or lotted item click the Zoom (^) button in the Quantity
Counted column.

Note:
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If B/T worksheet is created by I/C generate worksheet then the details for Serialized/Lot
quantities is entered as a variance.

If B/T worksheet is created by B/T generate worksheet then the details for Serialized/Lot
quantities is entered as a quantity counted.

STOCKING UNIT OF MEASURE

The stocking unit of measure for this item is displayed

COUNTED BY

Displays the user name.
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STATUS

Status can be:

Insufficient Quantity
On Hold
Ready
Pending (Pending is when it can't update this item because another line with
the same item is Insufficient Quantity)

REASON

The reason is used when the status is Insufficient Quantity and can be:

Lot %p has a variance of %b but there is only %b available.
Item has a total variance of %b but there is only %b available.
Item has a variance of %b but there is only %b available.

It basically says which item/lot has the problem and what the problem is.

BIN RECONCILIATION REPORT - FEATURES

The Bin Reconciliation report lets you compare actual physical inventory totals with the totals in your Bin
Tracking system.

The report identifies discrepancies between item quantities and shows what will be posted by the Post
Bin Reconciliation form.

Information printed on the report

The ranges of location sets selected when you generated the Inventory Worksheet.
The quantities on hand, calculated by Bin Tracking from the transactions posted for each item.
The physical count (quantity counted) you entered in the Bin Counts form for each item and bin
The variance, if any, between quantity on hand as calculated by Bin Tracking Control and the counted
quantity you entered.

The Include Bin’s version of the report includes a single line for each item and bin combination.

For instructions on printing the report, see Printing the Bin Reconciliation Report - Printing .
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POST BIN RECONCILIATION

For an overview of Stock take procedures, refer to Bin Tracking Stock Take Procedures on page 35

For details on the fields, refer to Post Bin Reconciliation - Field List on the next page

Use this form to post inventory counts that you entered in the B/T Physical Inventory, bin Inventory
Counts form.

When you post a Bin reconciliation, Bin Tracking will do the following:

1. Update I/C details

If the Bin Tracking Worksheet was generated by an I/C Inventory Worksheet, Post Reconciliation also
updates the associated I/C Inventory worksheet with the sum of the items per bin.

If the Bin Tracking Worksheet was generated by the Generate Bin Worksheet process in Bin Tracking,
Post Reconciliation creates an I/C Adjustment with either

The difference between the original quantity in the Bin Transfer Worksheet and
the counted quantity or
The difference between the original quantity in I/C and the counted quantity

2. Create Bin Transfer Documents

If the I/C worksheet is updated successfully or the I/C Adjustment above are created successfully, Post
Bin Reconciliation will create a Bin transfer document to increase/decrease the quantities per item per
bin. The Bin Transfer documents will be marked Complete.

3. Delete the BT Inventory Worksheet .

Important!
When an I/C Adjustment is created on posting a Bin Tracking Worksheet , the description is set to
"Created by B/T Stocktake". This is how Bin Tracking knows not to create another bin transfer for this
I/C Adjustment. If the description is changed in any way, then BT will create another Bin Transfer for
the I/C Adjustment.

The I/C Adjustment Description must not be changed.
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Note:
Posting Bin Reconciliation only update quantities

I/C supports Serial and Lot tracking amendments via quantity only. So, for example if you have 6 of an
item, all assigned to a single lot number, you cannot (via the stock take) amend the item to have 5
assigned to one lot, and one assigned to another lot. You can increase or decrease the quantity (and
assigned lot), but not “change” the lot only. Accordingly, in the Bin Tracking stock take worksheet gen-
erated from I/C if you amend the item to have 5 to one lot, and 1 to another - this will be allowed in
Bin Tracking but will give an error when posting through to the I/C Stock take.   

BEFORE POSTING A BIN RECONCILIATION
Print the bin reconciliation report

Click the Field List button at the top of this topic for information about fields on the Post Bin Recon-
ciliation form.

POST BIN RECONCILIATION - FIELD LIST
For an overview, refer to Post Bin Reconciliation on the previous page

FIELDS AND CONTROLS
FROM LOCATION

Enter beginning code or use the Finder to select beginning code in the range of locations for
which you want to post bin reconciliation adjustments.

TO LOCATION

Enter ending code or use the Finder to select ending code in the range of locations for which
you want to post bin reconciliation adjustments.

Creating I/C Adjustment options
If the B/T Worksheet being posted was created by “B/T Generate Bin Worksheet” you will be prompted
to select an option to create the I/C Adjustment: 

1. Adjust I/C quantities with the change in quantity entered in the Bin Worksheet.

Example: If the Bin quantity was 2 and you adjust to 1, the I/C adjustment would be cost/quantity
down by 1”

2. Adjust I/C quantities with the quantity required to make the I/C quantity for the location equal to the
adjusted quantity in the Bin Worksheet.
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Example: If the Bin Quantity was 2 and you adjust it to 1 and the I/C quantity was 3, the I/C adjust-
ment would be cost/quantity down by 2.

Important! Only choose this option if you have counted all the stock in the location.

I/C Adjustment Details
You can define the following details to be used when creating the I/C Adjustment :

I/C Adjustment Number to be used, or leave I/C Adjustment Number as *** NEW *** to allow
I/C to autonumber the I/C Adjustment.
Adjustment Date and Posting Date
Optionally, enter a reference

Note: The description will be set to “Created by B/T Stock Take” and cannot be overwritten.

Bin Options Setup Report - Printing
How to Print

1. Choose Bin Options Setup Report in the B/T Setup Reports folder.
2. The report file last used appears by default. The report OYSETOPT.RPT is used.  
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For more information on the contents of this report, see Item Bin Options Setup Report - Features below.

BIN SETUP REPORT - FEATURES
The Bin Setup report lists bins created per location, together with the setup options per bin.

The report can be filtered by

Location range
Bin Range

For instructions on printing the report, see Bin Setup Report - Printing

Information printed on the report

Location code and name
Bin code and description
Whether or not the bin is flagged as being active
Whether or not all items are allowed in the bin, or only specific items
The pick order of the bin
Whether or not receipt type transactions are allowed in that bin
The bin shortcut code – if entered.

BIN OPTIONS SETUP REPORT - FEATURES

The Options report lists the selected options and other information you entered in the Options form to
specify how your Bin tracking system operates.

For instructions on printing the report, see Bin Options Setup Report - Printing on the previous page

Information printed on the report

Picking Method Options.
Document Number Options.
Item rules
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Bin Tracking Customized Forms
Bin Tracking provides customized versions of the Sage 300 O/E, P/O and I/C forms to include the Bin
allocation. Customized Forms can be amended like other Sage 300 forms using Crystal Reports.

Note:
Customized Forms with Bin Tracking details are installed in the OYxxA \ ENG folder where Sage 300 is
installed. (e.g. OY72A\ENG for version 2025).

Users can browse to the OYxxA \ ENG folder to select the custom report or copy them to the appro-
priate customization directory.

FOR USE IN O/E ORDER ENTRY
OEOYPICKSHIP.RPT to print a picking slip from OE Shipment.

OEOYPICKORDER.rpt to print a picking slip from OE Orders.

Note: The OE Order form shows the "theoretical" allocation of bins -> i.e. if a shipment was
created right now. But this theoretical allocation of bins cannot take into consideration other
outstanding orders -> as the true allocation of the bins only happens when the OE Ship-
ment is created.

Note: Forms now include suggested bins for Kit components as well as regular Items.

FOR USE IN P/O PURCHASE ORDER
POOYRCP01.rpt to print a PO Receipt form with Bin Allocation.

FOR USE IN I/C STOCK CONTROL REPORT
ICOYTRNS.rpt to print I/C Transfer Slip report (use I/C Stock Control Report > Transfer Slips) in I/C and
select the report.

To use this report, you need to copy it from the OYxxA \ ENG to the ICxxA \ ENG folder (e.g.
OY72A\ENG to IC72A\ENG for version 2025).

Bin Transfer Document - Features

Bin Transfers show the number of items that are required to be picked or put away per bin.
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For instructions on printing the report, see Bin Transfer Document - Printing

Information printed on the report

The sample Bin Transfer document list all the items on a bin transfer document, together with the item
quantities and bins associated with each of the bin transfer lines.

The report can print details of Serialized and Lot numbers

Deactivate Empty Bins
When to use
Use this option to Deactivate Empty Bins.

Inactive bins no longer appear in Finders and transactions with current data. They will still appear on his-
toric reports where appropriate.

Tip:
It is not recommended to delete old bins - if they have been used at all.

We recommend that you rather use "Deactivate Empty Bins". This will make all empty bins inactive.
They can't be used for current transactions, but still appear on reports.

How to use
Select "Deactivate Empty Bins" in the Periodic Processing Menu.

You can select a from and to location range, and a from and to bin range.

Furthermore you can select if you only want to include Temporary Bins, or all bins. This option will make
all bins in the current from and to location and bin range which are empty inactive.

An empty bin is where quantity on hand for all items in the bin is zero.
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Bin Tracking Analytical Reports

Item and Bin Report - Features 51
Item and Bin Report - Printing 52
Bin Totals vs Location Total Report - Features 52
Bin Transfer Reconciliation Report - Features 53
Bin Transfer reconciliation Report - Printing 55
Bin Transfer History Report - Features 56
Bin Replenishment Report — Features 57
Empty Bin Report - Features 58

ITEM AND BIN REPORT - FEATURES

The item and bin report shows the Location/Bin/Item details, and the quantity on hand for each item, bin
and location combination.

The report can be filtered by:

Location range
Bin Range
Item Range

The report can be printed on one of the following sort orders:

By location, bin and item
By location, item and bin
By Item, location and bin
By Item, bin and location

The report can print details of Serialized and Lot numbers

For instructions on printing the report, see Item and Bin Report - Printing on the next page

Information printed on the report

The report includes
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Location code
Bin code
Item code
Unit of measure (if entered) for the item/bin/location combination.
Quantity on hand (in stocking unit of measure)

ITEM AND BIN REPORT - PRINTING

How to Print

1. Choose Item and Bin Report in the B/T Analytical Reports folder.
2. The report file last used appears by default. For the sample bin transfer document, select

OYBINITEM.RPT   

For more information on the contents of this report, see Item and Bin Report - Features on the previous
page.

BIN TOTALS VS LOCATION TOTAL REPORT - FEATURES

The Bin total vs. Location total shows the total quantities per item per bin and per location. You can
optionally 

Show all records or only those records where – for each item - the I/C Location quantity does not
equal the BT Location quantity (total by bin)
Show only the total of item quantities by bin per location or show the detailed bin numbers and
associated item quantities per bin

The report can be filtered by

Location range
Item Range

The report is sorted by location an item. Bin and item 
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For instructions on printing the report, see Bin Totals vs Location Total Report - Printing

Information printed on the report

The report includes

Location code and name
Item number and name
The active flag for the item in the location
Total I/C quantity for the item in the location
Bin transfer date and time last updated
Bin code (if showing bin details)
Bin quantity (if showing bin details)
Total item bin quantity per location
Computed variance column showing the difference between the I/C Location quantity and the BT
Bin quantity per item

.

BIN TRANSFER RECONCILIATION REPORT - FEATURES
The Bin Transfer Reconciliation report shows the details of Bin Transfer documents for the selection
range entered (1) .

The report includes the bin transfer quantities and the quantities on the original source document (in I/C,
O/E and P/O). You can select how to sort the details (2).

This report can be printed to show only the lines that have variances between the bin transfer quantities
and the original source document quantities (3).

For instructions on printing the report, see Printing the Bin Transfer reconciliation Report - Printing on
page 55
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The report can be filtered by: 
Location range
Item Range
Bin Transfer Range
Bin transfer document number range
Source Document number range
Bin transfer date range
Transaction Type
Bin Transfer Status

Sort Options
The report is sorted by I/C Locations. Within each location, you can choose to sort by: 

Item No
Bin Transfer number
Source Document number

Options
Select Include Lots or Include Serials to print details of Serialized and Lot numbers on the report.

Select Show Quantity Variance Lines Only to include only lines that have a variance between the bin
transfer quantities and the original source document quantities.
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Information printed on the report
When the source documents in I/C History (ICHIST) don't have a matching document in Bin Tracking, the
row is in Red in the report.

Bin transfer number
Date
Source Type
Location
Status
Item No
Bin No
Bin Transfer Quantity
Source Document
Source Document Quantity

BIN TRANSFER RECONCILIATION REPORT - PRINTING
For more information on the contents of this report, see Bin Transfer Reconciliation Report - Features on
page 53.

How to Print
1. Choose Bin Transfer Reconciliation Report in the B/T Analytical Reports folder.
2. The report file last used appears by default. For the sample bin transfer document, select

OYBINREC.RPT
3. Select the criteria to run the report and choose print.
4. Accept the message: IC Day End Processing has to be run prior to running the report, otherwise it

might not show the complete comparison.
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Note: The report should be faster as the OYBINREC.rpt report now uses a temp table. In prior versions,
the report used a SQL Command that may cause errors in some ODBC or SQL Server versions.

Tip: If you have customized the report, you can look at the new report and redo the customizations
based on the new report table structure.

Tip: If you get a Crystal Error when printing the report, go to B/T Options > Updates Tab and check
that you are running the latest product update before contacting support.

BIN TRANSFER HISTORY REPORT - FEATURES

The Bin Transfer History report shows the details of Bin Transfer documents for the selection range
entered.

The report can be filtered by

Location range
Bin Range
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Item Range
Bin transfer document number range
Bin transfer date range

The report is sorted by location. Within location, the report can be sorted by: 

Bin and item
Item and bin

The report can print details of Serialized and Lot numbers

For instructions on printing the report, see Bin Transfer History Report - Printing

Information printed on the report

The report includes

Location code
Bin code
Item code
Bin transfer number
Bin transfer date and time last updated
Bin transfer source type
Bin transfer source document
Source location (for pick type transactions)
Source quantity (for pick type transactions)
Destination location (for put away type transactions)
Destination quantity (for put away type transactions)

BIN REPLENISHMENT REPORT — FEATURES
The Bin Replenishment report shows which bins need replenishing. In order to be shown on this report,
you need to have entered a “Restocking Level” and “Restocking Quantity” for those items you require to
track - by bin. See Bin Setup on page 15 for further details on entering restocking levels and restocking
quantities for an item in a bin. You can select to either show all items, or only those item/bin com-
binations which need restocking (i.e. where the quantity on hand per bin is less than the restocking level
for that item and bin combination).   
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The report can be filtered by

Location range
Item Range
Bin Range

The report is sorted by location. Within location, the report can be sorted by: 

Bin and item

For instructions on printing the report, see Bin Replenishment Report - Printing

Information printed on the report

The report includes

Bin code
Item number and name
The quantity at which the item should be restocked in this bin
The quantity on hand in this bin for this item
The quantity by which this bin should be restocked if required
The quantity to restock this bin/item combination by

EMPTY BIN REPORT - FEATURES
The Empty Bin report those bins which are empty.

The report can be filtered by

Location range
Bin Range

The report is sorted by location and bin.

For instructions on printing the report, see Empty Bins Report - Printing

Information printed on the report
The report includes
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Bin code and description
Location code and description
If the bin is active
If all items are allowed in a bin or not
The bin pick order
Whether or not Receipt type transactions are allowed in this bin
The bin shortcut code (if entered)
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